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Challenge:
In this project, you will learn to create an HTML web page using Expression Web.  You will need 
to include a paragraph about yourself, which should include the following topics: * title of the 
page * your name * major of your study * any previous experience using Expression Web  and/or 
web related application(s) * whatever information you would like to share on your web site. 
Make sure to format the text and save your work as Project_2.htm.   

Summary:
Laboratory Project 2 provided an opportunity to experiment with the different capabilities, 
menus and tool pallets of Expression 4.  In the discussion below a very simple page is created 
with a title and a paragraph.  Various pallets were used from the design view to “craft” an 
interesting web page.  Two pages were created.  Project_2.html explored the use of background 
color.  Project_2a.html explored the use of images and text color.  Expression Web was run on a 
Mac in a Windows 8 virtual machine.

Step DiscussionDiscussion

1 Run Windows 8 as a virtual machine on the Mac.Run Windows 8 as a virtual machine on the Mac.
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Step DiscussionDiscussion

2 Launch Expression Web - Right click in open space. Chose APPS and 
select Microsoft Expression Web 4, which will be referred to as MSEW.
Launch Expression Web - Right click in open space. Chose APPS and 
select Microsoft Expression Web 4, which will be referred to as MSEW.

3 Save the untitled file as Project_2.html - Click on <File><Save> to open 
the file dialogue to save a file.  Navigate to the desired directory. rename the 
file “Project_2.html and select “Save”. 

Save the untitled file as Project_2.html - Click on <File><Save> to open 
the file dialogue to save a file.  Navigate to the desired directory. rename the 
file “Project_2.html and select “Save”. 
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Step DiscussionDiscussion

4 Select The View Mode - Located on the bottom left of the main window are 
three tabs: Design, Split and Code.  These tabs select the information 
displayed in the main window.  The Design tab allows for interactive 
placement of text and graphical elements in the main much like in a MS Word 
document.  As elements are added to the design view the corresponding 
HTML is generated.  That code can be viewed by selecting the Code tab. The 
Split tab displays both the Design view and the Code view together.   Since 
the purpose of the challenge was to explore MSEW not the HTML language it 
was decided to stay in Design View until the design was near completion 
before examining code view.  In that way the emphasis was placed on the 
MSEW tools.

Select The View Mode - Located on the bottom left of the main window are 
three tabs: Design, Split and Code.  These tabs select the information 
displayed in the main window.  The Design tab allows for interactive 
placement of text and graphical elements in the main much like in a MS Word 
document.  As elements are added to the design view the corresponding 
HTML is generated.  That code can be viewed by selecting the Code tab. The 
Split tab displays both the Design view and the Code view together.   Since 
the purpose of the challenge was to explore MSEW not the HTML language it 
was decided to stay in Design View until the design was near completion 
before examining code view.  In that way the emphasis was placed on the 
MSEW tools.
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Step DiscussionDiscussion

5 The project scope requires a single text element to be 
placed on the page, a short paragraph.  In the design 
view there is blinking cursor indicating a place to type 
text.  The lab objective could be met by simply typing 
the paragraph there.

However there were several curious pallets bordering 
the design window.  On of which is titled Toolbox and 
contains drag-able HTML tags.  After further 
examination it was discovered that a more interesting 
page could be developed by dragging the tags from 
the toolbar into the design window.  Of particular 
interest were the <div> and Layer tags as they 
allowed for precise position of text on the page.

<div> was dragged to the top left corner to contain the 
heading “About Mike Lawrence”.  

Layer was dragged as an indented text area to the 
heading to contain the paragraph.

I prefer a white web page like the www.apple.com.  
However for the purpose of experimentation colors 
and pictures were added.  Colors, pictures, font sizes 
line sizes are selected via menus and tool pallets.  the 
results are displayed and the appropriate code added.
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Step DiscussionDiscussion

6 Experimentation with colors and images - It was discovered that one way 
MSEW implements tag attributes such as colors, images, line style and fonts 
is by using the <style> tag in the header.  A second file, Project_2a.html, was 
added to focus on adding images.  When color and images were inserted, the 
following <style> tag was added to the header.

<style type="text/css">
.auto-style1 {
! background-color: #FFFFFF;
! background-image: url('BLUVINYL.PNG');
}
.auto-style3 {
! font-size: xx-large;
! color: #FFFFFF;
}
.auto-style4 {
! color: #FFFFFF;
! padding-top: 14px;
}
.auto-style5 {
! color: #FFFFFF;
! margin-left: 0px;
}
</style>

The .auto-style# was then referenced in the body with various tags.  For 
example, the heading tag referenced .auto-style5 to adjust color and position.

<h1 class="auto-style5">About Mike Lawrence</h1>

Similarly .auto-style1  was referenced by the div layer to provide an image and 
text color.  

<div id="layer1" class="auto-style1" style="position: absolute; width: 403px; height: 
446px; z-index: 1; left: 108px; top: 125px">
! <span class="auto-style3">My name is Michael Lawrence. I am a New Media 
major at 
Queensborough Community College. This is my first experience using Microsoft’s 
Expression Web. I have never worked with HTML before. I have created a couple of 
websites using Apples </span> <a href="http://www.apple.com/findouthow/web">
! <span class="auto-style3">iWeb</span></a><span class="auto-style3"> 
product, a drag and drop widget tool without access to the code.</span></div>

In Design View the attributes are set in Tag Property Pallet or the Layer 
Pallet’s Borders and Shading dialogue as shown in the next screen shot.
Two different images were assigned as attributes to the Layer and the 
Background.  The Layer text color was set to white and the size increased via 
the drop-down toolbar menus.  A line was added between the heading and he 
paragraph by dragging the line icon from the tool pallet and adjusting its 
attributes.

Experimentation with colors and images - It was discovered that one way 
MSEW implements tag attributes such as colors, images, line style and fonts 
is by using the <style> tag in the header.  A second file, Project_2a.html, was 
added to focus on adding images.  When color and images were inserted, the 
following <style> tag was added to the header.

<style type="text/css">
.auto-style1 {
! background-color: #FFFFFF;
! background-image: url('BLUVINYL.PNG');
}
.auto-style3 {
! font-size: xx-large;
! color: #FFFFFF;
}
.auto-style4 {
! color: #FFFFFF;
! padding-top: 14px;
}
.auto-style5 {
! color: #FFFFFF;
! margin-left: 0px;
}
</style>

The .auto-style# was then referenced in the body with various tags.  For 
example, the heading tag referenced .auto-style5 to adjust color and position.

<h1 class="auto-style5">About Mike Lawrence</h1>

Similarly .auto-style1  was referenced by the div layer to provide an image and 
text color.  

<div id="layer1" class="auto-style1" style="position: absolute; width: 403px; height: 
446px; z-index: 1; left: 108px; top: 125px">
! <span class="auto-style3">My name is Michael Lawrence. I am a New Media 
major at 
Queensborough Community College. This is my first experience using Microsoft’s 
Expression Web. I have never worked with HTML before. I have created a couple of 
websites using Apples </span> <a href="http://www.apple.com/findouthow/web">
! <span class="auto-style3">iWeb</span></a><span class="auto-style3"> 
product, a drag and drop widget tool without access to the code.</span></div>

In Design View the attributes are set in Tag Property Pallet or the Layer 
Pallet’s Borders and Shading dialogue as shown in the next screen shot.
Two different images were assigned as attributes to the Layer and the 
Background.  The Layer text color was set to white and the size increased via 
the drop-down toolbar menus.  A line was added between the heading and he 
paragraph by dragging the line icon from the tool pallet and adjusting its 
attributes.
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Step DiscussionDiscussion

7 Previewing Work  - The Display View cannot display 
all web page elements. It is accurate for viewing 
HTML but not HTML and, for example, JavaScript. It is 
necessary to preview code in an actual browser.  
MSEW has built in support to launch several different 
browsers to view how the code displays in them.  It is 
possible to launch IE, Chrome, Firefox, etc. and 
critique how the code displays in each.  In this Lab we 
used IE 9.10 via the toolbar icon to the right.  
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Step DiscussionDiscussion

8 Conclusions: MSEW is very powerful visual programing environment that 
gives the programmer complete control over the code.  The programmer has 
the choice of using the attribute tool pallets and other GUI resources or 
directly coding.   All of the attributes that could be set in code can be selected 
from the various pallets and menu choices.

Because Project_2a.html has images, those images were placed on a server 
in Amazon S3 for easy access.  Also a web archive containing the images 
was made, “AboutMikeLaawrence.html”, so that the file could be viewed 
without internet access. It was created by saving “Project_2a.html” from a 
Safari browser using the web archive option.

Conclusions: MSEW is very powerful visual programing environment that 
gives the programmer complete control over the code.  The programmer has 
the choice of using the attribute tool pallets and other GUI resources or 
directly coding.   All of the attributes that could be set in code can be selected 
from the various pallets and menu choices.

Because Project_2a.html has images, those images were placed on a server 
in Amazon S3 for easy access.  Also a web archive containing the images 
was made, “AboutMikeLaawrence.html”, so that the file could be viewed 
without internet access. It was created by saving “Project_2a.html” from a 
Safari browser using the web archive option.

ET-710 Project 2

Michael Lawrence page 8 of 10



Critical Thinking Questions:

Critical Thinking Questions And AnswersCritical Thinking Questions And Answers

Question 1 What are the view features in Expression Web?  

Answer The view features in Expression Web allow the user to view either the 
Design View, the Code View or Both Views.  Located on the bottom 
left of the main window are three tabs: Design, Split and Code.  
These tabs select the information displayed in the main window.  The 
Design tab allows for interactive placement of text and graphical 
elements in the main much like in a MS Word document.  As elements 
are added to the design view the corresponding HTML is generated.  
That code can be viewed by selecting the Code tab. The Split tab 
displays both the Design view and the Code view together. 

Question 2 How to change text color and background color?

Answer The programmer can from code view insert the appropriate HTML tag 
attributes for text color and background color or from design view, let 
MSEW handle it via the pallets and style tags as outlined in Step 6 of 
the discussion above.

Question 3 What are the three ways to open a web file?

Answer 1) Outside of MS Expression Web (MSEW) from the file system, 
double clicking the ".html" icon will launch it in the default application 
associated with its filetype.  If MSEW is the default application for 
the .HTML extension the file will open in MSEW.  

1a)  If MSEW is not the default application, it can be selected to pen 
the file by right clicking the file icon and selecting  "<Open With> MS 
Expression".

2). The .HTML can be opened from inside MSEW from the 
<File><Open> menu by selecting it.

3) The .HTML the MSEW <Sites> menu.

Question 4 How to run/preview a web page in Expression Web?
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Critical Thinking Questions And AnswersCritical Thinking Questions And Answers

Answer 
Preview is run by 1) pressing F12 or 2) clicking the tool bar icon 
or 3) the menu selection <File> <Preview in Browser>

Question 5 How to request help in Expression Web?

Answer Help is requested by pressing F1 or by going to the <Help> Menu item.
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